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MS Word

1 Which command is used to store the active document permanently?
A Save

B Send

C Prepare

D Save as

Ans. a

2 Which shortcut key is used to high light the entire word document?
Actrl + A

Bctrl+ O

Cctrl+S

Dctrl+ E

Ans. a

3. The print resolution (quality) and colour preferences may be set using option available in
print dialog.

(a) collate

(b) scale

(c) printer properties>Finishing->Print on both sides

(d) Properties>Paper/Quality

Ans. d

4.What is the purpose of quick access toolbar?
A To hold advance function

B To hold special function

C To hold basic function

D To hold familiar and repeated function

Ans. d

5 Which bar contains the current position of the cursor in MS Word?
A layout

B title bar

C status bar

D horizontal ruler

Ans. c

6 Where does the close button appear in MS Word?

A top left corner of the window B bottom left corner of the window
C top right corner of the window D bottom right corner of the window
Ans. c

7.Which one of the following is text styling feature of MS Word?
Aword fil B wordart C word colour D word font
Ans. b

8.Which option is used to view an exiting word document?
A new B open

C publish D prepare

Ans. b
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9.Which document view given an appearance as in web browser?
A Draft view

B Outline view

C Web layout view

D Full screen reading

Ans. c

10.How many groups are there in Home Menu?
A4 B5 C6 D7

Ans. b

11.Which group includes superscript, subscript, strike through options in MS Word?
A Clipboard B Font C Paragraph D Style

Ans. b

12.What in the purpose of Xl button?
A Close button

B Office button

C Maximize buttons

D Minimize button

Ans. a

13.What is the purpose of zoom option?

A Enlarge and reduce document / text size

B Move up and down document / picture

C Scroll left and light document / picture

D Minimize and maximize the document/ picture
Ans. a

14.Which option is used for tab setting?

A horizontal ruler B status bar
C vertical ruler D vertical scroll bar
Ans. a

15.What in the purpose of vertical scroll bar?

A Move the document up and down B Move the document left side
C Move the document right side D Move the document only upwards
Ans. a

16.What in the purpose of undo action in MS Word?
A Restore previous action

B Get the current action

C Goes to previous page

D Goes to previous paragraph

Ans. a

17.Which option is used to activate and deactivate ruler?
A View — grids

B View — ruler

C Insert — tool bar

D Insert — ruler

Ans. b
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18.What is the purpose of cover page?

A Allows to fill title, author, date and other information
B Fills the list of people intent to mail

C To view the mailed list

D Contains details of the documents

Ans. a

19.Which menu contains, Symbol option in MS Word?
A tools

B table

C format

D insert

Ans.d

20.Which option is used to locate any specific character, symbols or formulas in.a document?
A Find

B Searching text

C Replace

D Selecting text

Ans. a

21.Which feature is used to create a newspaper type document?

A Tables B Tab stops
C Columns D Bullets and numbering
Ans. c

22.Which sequence of operation is required to insert bullets for list of data?
A Paragraph group — numbering button — select any humber type

B Paragraph group — number button — select none

C Paragraph group — bullet button — type of bullets

D Paragraph group — bullet button — select none

Ans. c

23.Which sequence of operation is required to remove numbering from a list of data?
A Number button'— select none from number type

B Number button — select number from number list

C Bullet button — select none from bullet type

D Bullet button — select bullets from bullets list

Ans. a

24 \Which sequence of operation is required to remove tab stop markers from ruler?
A Drag the tab stop makers out of the ruler

B Double click the tab marker and clear all

C Right click the tab stop marker and choose remove

D Left click the tab stop marker and choose remove

Ans. a

25.Which feature is used to adjust the amount of space between words for alignment in MS Word
A Spacing B Scaling

C Justifying D Positioning

Ans. c



26.How can we rectify the errors occurs while typing?
A Auto entry

B Auto add

C Auto spell

D Auto correct

Ans.d

27.Which sequence of operation is required to force page break in word document?
A by using insert / selection black on the insert tab

B by positioning the cursor at the appropriate place and press enter

C by positioning the cursor at the appropriate place and press F1 key

D by position the cursor at the apporpliate place and pressing ctrl + enter

Ans.d

28.What is the purpose of inserting header and footer in document?
A To make the starting and ending page

B To entrance the appearance of the document

C To make larger document more readable

D To allow page headers and footer appear on the document

Ans. d

29.What is purpose of thesaurus tool is MS Word?

A Grammar option B Spelling suggestion

C Synonyms and antonyms words D Auto correction

Ans. c

30. MS word is a software.

a) Word Processing b) word editor c) Text editor
Ans. A

31. Extension name of word 2004 .

a) .doc b) .docx c) .txt d).jpg

Ans. A

32. In MS word, ctrl+s is for.........

a) scenarios b) size C) save d) spelling check
Ans. c

33. Which key.is used to increase left indent ?
a) ctrl + 1 b)ctrl+ m  c¢)ctrl +f d)ctrdl +n
Ans. b

34. which key is used to select all the text in the document?
a)ctrl +a b)ctrl+m c¢)ctrl +f d)ctrdl +n
Ans. a

35.To undo the last work, press....
a)ctrl+a  b)ctrl +z c)ctrl +f d) ctrl + n
Ans. b
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d) typing
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36.What is the purpose of gutter margin?

A Margin that is added to the left margin when printing

B Margin that is added to the right margin when printing

C Margin that is added to binding side of page when printing

D Margin that is added to the outside of the page when printing

Ans. c

37. Portrait and Landscape are
a) page orientation b) paper size C) page layout d) all of above
Ans. a

38. If you need to change the typeface of a document, which menu will you choose?
a) edit b) view c) format d) tools
Ans. c

39. What is the portion of a document in which you set certain page formatting options?
a) page b) document c) section  d) page setup
Ans. c

40. Boarders can be applied to

a) cells b) paragraph c) text d) All of these

Ans. d

41. Which of these toolbars allows changing of fonts and their sizes?

a) standard b) formatting c) print. preview d) none of these
Ans. b

42. Microsoft word can be started via?

a) start menu b) desktop c)Aand B  d) None

Ans. c

43. Which option are used for opening, saving, important files?

a) print b) file c) tool d) none

Ans. b

44. What is the shortcut for printing?

a)Alt+p b) Space + P c)Ctrl+p d)ctrl+z
Ans. ¢

45. what is the shortcut for saving a document?

a)Alt+p b) Space + P c)Ctrl+p d)ctrl+s
Ans. d

46. In order to create an new file from an existing file, we use?
a) save b) save as c) print d) scan
Ans. b

47. Header appears on the of the page?

a) Top b) Bottom c) Centre d) Side

Ans. a
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48. The collection of Microsoft tools for preparation of documents, spreadsheets, presentations,
database management, time scheduling and mailing is called

(a) MS Office

(b) OpenOffice.org

(c) Star Office

(d) Libre Office

Ans. a

49, In MS Office, is the software for preparation of documents.
(a) MS Access

(b) MS Word

(c) MS Excel

(d) MS Powerpoint

Ans. b

50. The default extension for an MS Word document is )
(a) .docx (b) .doc (c)botha &b (d) neither a nor b
Ans. c

51. MS Word can be used for the preparation of
(a) letters

(b) books/ reports/theses

(c) brochures/ visiting cards

(d) all of them

Ans. d

52. In Graphical User Interface (GUI) based programs, WYSWYG stands for .
(a) Whatever You See, Wherever You Get (b) What You See, What You Get

(c) Whichever You See, What You Get (d) Wherever You See, What You Get
Ans. b

53. The paradigm of WYSWYG signifies that

(a) the printed document resembles exactly what you see on screen
(b) printed document is different from that on screen

(c) screen document is better than printed one

(d) printed one is better than screen document

Ans. a

54. inMS Word serves as a standard typeset document for creating professional looking
documents.

(a) Macro (b) XML (c) Template (d)y HTML

Ans. c

55. The collection of artworks/images available in MS Office is called

(a) drawing (b) images
(c) cliparts (d) tables
Ans. c

56. To create mail merged results, MS Word can take address input from
(a) MS Excel (b) MS Access

(c) text files (d) all of them

Ans. d



57. In MS Word, grammatic errors are highlighted by .
(a) bold text

(b) green underline

(c) red underline

(d) italic text

Ans. b

58. MSWord can handle to enrich a document.

(a) lists (b) images

(c) tables (d) all of them

Ans. d

59. The text or image which appears faintly in the background of a page is called
(a) water mark (b) trade mark

(c) copy right (d) embossing

Ans. a

60. MS Office button is located on the of MS Word window.

(a) top right (b) top left (c) bottom left (d) bottom right
Ans. b

61. is the shortcut to open Office menu of MS Word.

(a) Alt+H (b) Alt + N (c)Alt+ P (d)Alt +F

Ans. d

62. The save button is MS Office menu can be accessed through
(@)At+F+S

(b) Ctrl + S

(c) both Alt + F + S &Ctrl + S
(d) none of them

Ans. c

63. To access Save As item in Office menu of MS Word, use shortcut.
(@)Alt+F +A (b) Ctrl + O (c)Ctrl + N (d)Ctrl +P
Ans. a

64. To select Open item in Office menu of MS Word, use shortcut.
(@) Ctrl + O

(b)At+F+O

(c) both Ctrl + O &Alt + F + O

(d)Ctrl +8

Ans. c

65. For Close item in MS Office menu, use shortcut.

(@ Alt+F+A (b) Ctrl + O

(c)Ctrl + N (d)Alt+F+C

Ans. d
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66. The first menu, containing most common tools required for preparation of document in MS

Word, is called i
(a) Home (b) Insert (c) Page Layout (d) References
Ans. a
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67. The tools for Clipboard, Font Style, Paragraph Formatting, Styles & Search are contained in

menu.

(a) Home (b) Insert

(c) Page Layout (d) References

Ans. a

68. is the shortcut for Home menu in MS Word.

(a) Alt+H (b) Alt+N

(c) Alt+P (d) Alt+S

Ans. a

69. menu permits insertion of tables, images, drawing objects and hyperlinks, headers and
footers in MS Word.

(a) Home (b) Insert (c) Page Layout (d) References

Ans. b

70. is the shortcut for Insert menu in MS Word.

(a) Alt+H (b) Alt+N (c) Alt+P (d) Alt+S

Ans. b

71. menu contains tools to control theme, page setup, page background, paragraph &
text wrap.

(a) Home (b) Insert (c) Page Layout (d) References

Ans. c

72. is the shortcut for Page Layout menu in MS Word.

@) Alt+H (b) Alt+N
(C)Alt+P  (d) Alt+S

Ans. c

73. menu contains tools related to table of contents, foot notes, citation, bibliography,
caption, index & table of authorities.

(a) Home (b) Insert (c) Page Layout (d) References

Ans. d

74. is the shortcut for References menu in MS Word.

(a) Alt+H (b) Alt+N (c) Alt+P (d) Alt+S

Ans. d

75. menu contains tools for creating mailings, merging mails, inserting merge fields,

preview of mail merged results, printing mail merged pages or saving the mail merge results in a
new file.

(a) Home (b) Mailings (c) Review (d) References
Ans. b
76. is the shortcut for Mailings menu in MS Word.

(a) Alt+H (b) Alt+M
(c) Alt+R (d) Alt+S
Ans. b
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77. menu contains tools for proofing, languages, comments, tracking, changes, compare
& protect.

(a) Home (b) Mailings

(c) Review (d) References

Ans. c

78. is the shortcut for Review menu in MS Word.
(a) Alt+H (b) Alt+M
(c) Alt+R (d) Alt+S

Ans. c

79. menu contains tools for document views, showing/hiding ruler, zoom, managing
windows & macros.

(a) View (b) Mailings

(c) Review (d) References

Ans. a

80. is the shortcut for View menu in MS Word.

(a) Alt+W (b) Alt+M

(c) Alt+R (d) Alt+S

Ans. a

81. menu contains items required for mail merge functionality in MS Word.
(a) Home (b) Insert

(c) Mailings (d) Reference

Ans. c

82. A set of VBA instructions toassist in carrying out recurring activities in is called
(a) mail merge (b) macro

(c) thesaurus (d) spell check

Ans. b

83. On opening MS Word (without clicking on a target document), it displays document.
(a) previous (b) formatted (c) completed (d) blank/ new

Ans. d

84. MS Word provides to function as the starting point special new documents like report,
visiting card, brochure, etc.

(a) template (b)macro  (c) image (d) table

Ans. a

85. After opening. a new document in MS Word, one should to create a comfortable
experience.

(a) set paper size

(b) set font size

(c) set paragraph spacing, line spacing
(d) all of them

Ans. d
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80. are the most important objects used in MS Word documents.
(a) tables & pictures

(b) shapes, flow charts & clip arts

(c) equations, lists, bullets & numbering

(d) all of them

Ans. d

87. MS Word has the ability to automate repeated tasks using

(a) tables (b) pictures

(c) equations (d) macros

Ans. d

88. In MS Word, a Macro may be assigned to invoke its functionality.

(a) keyboard shortcut

(b) a button

(c) either keyboard shortcut or button
(d) neither keyboard shortcut nor button
Ans. c

89. In MS Word, the default macro security setting is
(a) Enable all macros

(b) Disable all macros

(c) Trust VBA Code

(d) Do not trust VBA code

Ans. b

90. In MS Word, it is better change macro security setting to before starting record or
use macros.

(a) Enable all macros (b) Disable all macros

(c) Trust VBA Code (d) Do not trust VBA code

Ans. a

91. While creating a macro, its availability may be
(a) granted to all documents

(b) restricted to the current document

(c)botha &b

(d) neither a nor b

Ans. ¢

92. The feature in MS Word which helps to create customized correspondence targeting different
recipients is called

(a) mail merge (b) charting

(c) clip art (d) equations

Ans. a

93. A mail merge document requires a to fill the blank spaces.
(a) picture

(b) record source

(c) chart

(d) equation

Ans. b



Page | 282

94. In MS Word, data sources for mail merge may be prepared using

(a) MS Excel

(b) MS Access

(c) Plain text file with tab for field separation & newline for record separation
(d) all of them

Ans. d

95. A standard standard document with proper formatting and layout may be saved as a ,
which may be used as the base for new documents.

(a) template

(b) pdf file

(c) plain text file

(d) HTML file

Ans. a

96. A document may be saved as a template using File>Save As from the menu and choosing
as the document type.

(a) Excel Template

(b) HTML file

(c) Word Template

(d) Open Document Format (ODF)

Ans. c

97. Default extension for word template is .
(a) .docx (b) .dotx (c) .xIsx (d) .pptx
Ans. b

98. Content created using template document

(a) should be saved as Excelfile

(b) should be saved as new word document

(c) should be saved as new power point document
(d) none of them

Ans. b

99. Magazines, journals and proceedings may publish for the help of authors in following
the right styles for publication.

(a) picture (b) screenshot

(c) template document (d) Excel spreadsheets

Ans. ¢

100. When the width of paper is smaller and height of paper is larger, the orientation is called
(a) landscape (b) portrait (c)botha &b (d) neither a nor b
Ans. b

101. When the width of paper is larger and height of paper is smaller, the orientation is called .
(a) landscape

(b) portrait

(c)botha & b

(d) neither a nor b

Ans. a
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102. Commonly used paper sizes for MS Word documents are

(a) A4 (b) letter
(c) legal (d) all of them
Ans. d

103. In MSWord, a document may be printed using .
(a) File>Print (Ctrl+P)

(b) Home>Copy (Ctrl+C)

(c) Home>Cut (Ctrl+X)

(d) Home>Paste (Ctrl+V)

Ans. a

104. MS Word document typeset on specific paper size may be printed on a different paper size
using option available in print dialog.

(a) collate

(b) scale

(c) printer properties>Finishing->Print on both sides

(d) Properties>Paper/Quality

Ans. b

105. Multiple copies of a document may be printed in complete sets (divide by set) using
option available in print dialog.

(a) collate

(b) scale

(c) printer properties>Finishing->Print on both sides

(d) Properties>Paper/Quality

Ans. a

106. A document may be printed on both sides of paper using ____ option available in print dialog.
(a) collate

(b) scale

(c) printer properties>Finishing >Print on both sides

(d) Properties>Paper/Quality

Ans. c

107. The ability to combine name and address with a standard document is called
a) Document formatting  b) Database management

c) Mail merge d) Form letters

Ans. ¢

108. A word processor would most likely be used to do

a) keep an account of money b) Do a computer search in media center

c) Maintain an inventory d) Type a biography

Ans. d

109. Which of the following is not essential component to perform a mail merge operation?

a) Main document b) Data source c) Merge fields d) word fields

Ans. d

110. Auto correct was originally designed to replace words as you type.

a) Short, repetitive b) Grammatically incorrect d) Misspelled d) None of these

Ans. c
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111. Home key is used for

a) Moves the cursor beginning of the document
b) Moves the cursor beginning of the paragraph
c) Moves the cursor beginning of the screen

d) Moves the cursor beginning of the line

Ans. d

112. Which file starts MS Word?

a) Winword.exe b) Word.exe c) Msword.exe d) Word365.exe
Ans. a

113. What are inserted as cross-reference in Word?

a) Placeholders b) Bookmarks c) Objects  d) Word fields

Ans. d

114. Which of the following is not the section break option?

a) Next page b) Previous page c¢) Odd page d) Even page
Ans. b

115. Which of the following is not valid version of MS Office?
a) Office 2007 b) Office Vista c) Office 2016 d) Office 365

Ans. b

116. By default, on which page the header or the footer is printed?

a) On first page b) On alternate page c) On every page d) None of these
Ans. c

117. Where can you find the horizontal split bar on MS Word screen?

a) On the left of horizontal scroll bar b) On the right of horizontal scroll bar

c) On the top of vertical scroll bar d) On the bottom of vertical scroll bar

Ans. c

118. When sharing data in Office, the document is the document in which the data was
first entered.

a) Source -b) Destination c).Original  d) Primary

Ans. a

119. To verify that the note text is positioned correctly on the page, switch to view or display

the document.in print preview.
a) Normal b) Print layout c) Page layout d) Page edit
Ans. b

120. Which of the following is true regarding page Orientation of a document?
a) Page orientation can be changed at any time

b) Page orientation of document determined by printer

Ans. a

121. Which feature helps you to inserts the contents of the Clipboard as text without any
formatting?

a) Paste Special  b) Format Painter c) Page Setup d) Styles

Ans. a
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122. Switching between portrait and landscape modes involves the:

a) Header and footer toolbar b) Print layout view
c) Page setup dialog box d) None of these
Ans. c

123. Where can you change the vertical alignment?

a) Formatting toolbar b) Paragraph dialog box

c) Page Setup dialog box d) Standard toolbar

Ans. c

124. A is a collection of predefined design elements and color schemes.

a) Feature b) Hyperlink c) Palette  d) Theme

Ans.d

125. Change the to create a document in Wide format

a) Page Orientation b) Page margin c) Paper Style d) Paper Source
Ans. a

126. formatting is the process of changing the way letters, numbers, punctuation marks,
and symbols appear on the screen and in print.

a) Document b) Character c) Paragraph d) Object

Ans. b

127. The word count command on the tools menu displays the number of words as well as the
number of in the current document.

a) lines b) Characters c) Paragraph d) All'of these

Ans. d

128. Which operation you will perform if you need to move a block of text?
a) Copy and Paste b) Cutand Paste.  c) Paste and Delete d) Paste and cut
Ans. b

129. To instruct word to stop bulleting paragraphs, do any of the following except
a) Press the enter key twice

b) click the undo button on the standard toolbar

c) Press the backspace key to remove the bullet

d) click the bullets button on the formatting toolbar

Ans. b

130. Which of these toolbars allows changing of fonts and their sizes?

a) Standard b) Formatting c) Print Preview d) None of these

Ans. b

131. To view header and footers, you must switch to

a) Normal view b) Print layout view c) Print preview mode d) BothBand C
Ans. d

132. From where you can access save command?
a) Home tab b) Insert tab c) Review tab d) None of these
Ans. d
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133. Which of the following is not available on the Ruler of MS Word screen?
a) Tab stop box b) Left indent c) Right indent d) Center indent
Ans. d

134. In word, the default alignment for paragraphs is
Ans. Left alignment, or flush margins at the left edge and uneven edges at the right edge

135. If you will be displaying or printing your document on another computer, you’ll want to make
sure and select the option under the ‘save’ Tab.
Ans. Embed Fonts

136. If you need to double underline a word, how will you do that?
Ans. Select the text then choose format > font and on font tab, open underline style ad choose
double underline

137. How can you apply exactly the same formatting you did to another text?
Ans. Select the text then click on Format Painter and select the new text

138. Which of the following is not one of the three ‘Mail Merge Helper' steps?

a) Merge the two files b) Create the main-document
c) Set the mailing list parameter d) Create the data source
Ans. c

139. To select a block of text, click at the beginning of the selection, scroll to the end of the

selection, position the mouse pointer at the end of the selection, hold down the key, and then
click or drag through the text.

Ans. Shift

140. A word field may consist of an optional field instruction called a(n)

Ans. Switch

141. It is possible to a data source before performing a merge.

a) Create b) Modify c) Sort d) All of these

Ans. d

142. Word has Web authoring tools allows you to incorporate on Web pages.
a) Bullets b) Hyperlinks c) Sounds d) All of these

Ans. d

143. Which of the following commands should you always use before submitting a document to
others?

a) Find command - b) Replace command c) Spelling and Grammar d) Thesaurus
Ans. c
144. Insert Date, Format Page Number, and Insert Auto Text are buttons on the toolbar.

Ans. Header and Footer

145. Which of the following do you use to change the margins?
a) Formatting toolbar b) Page setup dialog box

c) Standard toolbar d) Paragraph dialog box

Ans. b
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146. A screen element of MS word that is usually located below the title bar that provides
categorized options is
Ans. Menu Bar

147. In Word 2007 the Zoom is placed on

a) View tab b) Home tab c) Status Bar d) A & C both
Ans. d
148. The is a short horizontal line indicating the conclusion of a document.

Ans. End mark

149. What is the valid Minimum and Maximum zoom sizes in MS word?

Ans. 10, 500

150. You can replace the text

a)ctrl + H b) Ctrl + R c) Replace from edit menu d) Both Aand C
Ans. d

151. The following tool bars display in the Word application window by default

a) Forms tool bar  b) Formatting tool bar c) Drawing tool bar d) All of these
Ans. b

152. A table

Ans. Is a grid organized in columns and rows

153. The four types of mail merge main documents are
Ans. Form letters, envelops, mailing labels and catalogue

154. Which of the following cannot be done with. document version?

a) Modifying a version b) Deleting a version c) Opening a version d) None of these
Ans. d

155. We can insert maximum-number of columns in MS word are

Ans. 63

156. Which of the following is not the merge process?

a) Preview the merge results b) Format a main document

c) Edit a data source d) Identify the main document

Ans. b

157. When you want to view different parts of a document without moving the insertion point
a) Use the previous page or next page buttons

b) Use the keyboard

c) Use the vertical and horizontal scroll bars

d) Use the zoom button

Ans. c

158. In the merge process, you can

a) Preview a merge b) Merge directly to a printer
c) Merge to new documents d) All of these

Ans. d
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159. To view smaller text on the screen you can
Ans. Decrease the view percentage

160. The minimum number of rows and columns in MS Word document is
Ans. 1 and 1

161. What is the smallest and largest font size available in font Size tool on formatting toolbar?
Ans. 8 and 72

162. A character that is raised and smaller above the baseline is known as
Ans. Superscript

163. Selecting text means, selecting

a) A word b) An entire sentence ¢) Whole document d) Any of these

Ans. d

164. In MS-Word, for what does ruler help?

a) To set tabs b) To setindents c¢) To change page margins d) All of these
Ans. d

165. Which option in File pull down menu is used to close a file in MS Word?
Ans. Close

166. What is the extension of files created’in MS-Word 97-2003
Ans. .doc

167. Why headers and footers used in MS-Word
Ans. To allow page headers and footers to appear on document when it is printed

168. What is the default number of lines to drop for drop cap?
Ans. 3

169. A bookmark is an item or location in document that you identify a name for future Reference.
Which of the following task is accomplished by using bookmarks?
Ans. To quickly jump to a specific location in the document

170. What is the maximum number of lines you can set for a drop cap?
Ans. 10

171. How can you insert a sound file in your word document?
Ans. From insert > object menu option

172. Macros are:
Ans. Small programs created in MS-Word to automate repetitive tasks by using VBA

173. A template stores:

a) Graphics, text, styles, macros b) Customized word command setting
c) Auto text entries d) All of these
Ans. d

174. What do mean by vertical separation between columns?
Ans. Margin
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175. What is the maximum font size you can apply for any character?
Ans. 1638

176.To Auto fit the width of column
Ans. Double click the right border of column

177. When inserting page number in footer it appeared 1 but you wish to show a. How you can do
that?
Ans. Click on Page Number Format tool and specify required setting

178. To get to the ‘Symbol’ dialog box, click on the menu and choose ‘Symbol’.
Ans. Insert

179. In, Word, the mailing list is known as the
Ans. Data source

180. What is the default font size of a new Word document based on Normal template?
Ans. 11 pt (Point)

181. Which indent marker controls all the lines except first line?
Ans. Hanging Indent Marker

182. Which of the following option is not available in Insert > Picture?
a) Chart b) Graph c)clip Art  d) Word Art

Ans. b

183. How many different position can you set for drop cap

Ans. 2

184. Which of the following is used to create newspaper style columns?
a) Format columns b) Table Insert Table

c) Format Tabs d) Insert Textbox

Ans. a

185. Column dialog box can be opened from

a)Press Alt+ O +C b) Format menu Column submenu
c) double click on column space in ruler d) All of these

Ans. d

186. You can jump to the next column by

a) press Alt + Down arrow b) clicking with your mouse on the next column
c) both A and B d) none of these

Ans. c

187. To open columns dialog box quickly
Ans. Double click the space between area on ruler

188. Text boundary can be displayed or hidden from
Ans. Options from Tools menu

189. You wished to justify text over the height of paper, which option will you choose
Ans. Page Setup from File menu
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190. Which of the following is not the part of standard office suite?
a) Database b) File manager c) Image Editor d) Word Processor
Ans. b

191. Where can you find the Draw Table tool button?
Ans. Tables and Formatting toolbar

192. Superscript, subscript, outline, emboss, engrave are known as
Ans. Font effects

193. Shimmer, Sparkle text, Blinking Background etc. are known as
Ans. Text effects

194. The feature of Word that automatically adjusts the amount of space between certain
combination of characters so that an entire word looks more evenly spaced. What is that feature
called?

Ans. Kerning

195. A feature of MS Word that saves the document automatically after certain interval is available
on .
Ans. Save tab on Options dialog box

196. When assigning a shortcut key to a symbol, you should always try to select a key or key
combination that is:
Ans. Unassigned

197. Suppose you wanted to create an AutoCorrect entry that would type the words ‘We regret to
inform you that your submission has been declined’ Of the following choices, which would be the
best name you could assign to this entry?

Ans. Subdual

198. If you want to convert a symbol or several lines of text into an AutoCorrect entry, you should:
Ans. Insert the symbol or type the text in a Word document first. Then, select the text or symbol
and got to the AutoCorrect dialog box.

199. What is the smallest width of a column?
Ans. 0.5”

200. Blinking point which shows your position in the text is called
Ans. Cursor

201. Which of the following position is not available for fonts of MS Word?
a) Normal b)Raised c)Lowered d) Centered
Ans. d

202. Uppercase on Change case dialog box and all Caps on Fonts dialog box both converts
selected text into Capital letters. What's the different between the two?
Ans. Change Case makes conversion permanent but all caps on font can always be reverted

203. Changing the appearance of a document is called
Ans. Formatting



204. The various types of marged documents produced are .
a) Directory lists b) Invoices c) Address lists d) All of these
Ans. d

205. Which of the following functions can be done on word?
a) Typing b) Editing  c¢) Mail merge d) All of these
Ans. d

206. In order to complete extract one piece of content to another place, we use?
Ans. Cut

207. The first line of the paragraph is called?
Ans. Indent

208. We can insert in the word?
a) Bullet b) Numbers c) Slashes d) All.of these
Ans. d

209. Which option allows us to link word directly to e=mail?
Ans. Mail merge

210. Which option enables us to create envelops and lables?
Ans. Mail merge

211. Which tool in MS Word is used to keep the familiar and repeated options?
A title bar

B task bar

C scroll bar

D quick access tool bar

Ans. d

212. Which area in MS Word.is used to enter the text?
A work space B work sheet

C slides D work book

Ans. a

213. Which one of the following is a word processor?

A MS'Word B MS Excel
C MS Access D MS Office publisher
Ans. a

214. Which option is used to store the duplicate of the active document permanently?
A Save

B Send

C Save as

D Rename

215. In MS Word, spelling mistakes are highlighted by .
(a) bold text (b) green underline

(c) red underline  (d) italic text

Ans. c
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216. Which of the following are word processing software?
a) WordPerfect b) WordPad c) MS Word d) All of these
Ans. d

217. Which enables us to send the same letter to different persons?
a) Macros b) Template c) Mail merge d) None of these
Ans. c

218. Which option is used for saving content to an existing file?
a) save b) save as c) import d) mail merge
Ans. a

219. What is gutter margin?

a) margin that is added to the left margin when printing

b) margin that is added to right margin when printing

¢) margin that is added to the binding side of page when printing
d) margin that is added to the outside of the page when printing
Ans. c

220. Which operation is to be performed before paste?
ACtrl+V

B Cut / copy

C Select all

D Select text

Ans. b

221. Where does the file name of the active document displays?
A title bar

B task bar

C menu bar

D status bar

Ans. a

222. Extension name of word 2007 and above

a) .doc b) .docx c) .txt ' d) . accdb
Ans. b

223. The highest Font size in.MS word is

a)72 b) 255 c) 1024 d) 1638

Ans. d

224. Which language does MS Word use to create Macros?
a) Visual Basic b) C ++ c) JavaScript d) HTML
Ans. a
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